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FOURIER  TRANSFORM  INFRA-RED  (FTIR)  SPECTROSCOPY 
 

PART ONE     THEORY AND OPERATION PRINCIPLE OF FTIR SPECTROMETER 

1.  INTRODUCTION 

The total internal energy of a molecule in a first approximation can be 

resolved into the sum of rotational, vibrational and electronic energy 

levels. Infrared spectroscopy is the study of interactions between matter 

and electromagnetic fields in the IR region. In this spectral region, the 

EM waves mainly couple with the molecular vibrations. In other words, a 

molecule can be excited to a higher vibrational state by absorbing IR 

radiation. The probability of a particular IR frequency being absorbed 

depends on the actual interaction between this frequency and the molecule. 

In general, a frequency will be strongly absorbed if its photon energy 

coincides with the vibrational energy levels of the molecule. IR 

spectroscopy is therefore a very powerful technique which provides 

fingerprint information on the chemical composition of the sample. FTIR 

spectrometer is found in most analytical laboratories. 

 

2.  MATHEMATICAL EXPRESSIONS OF FOURIER TRANSFORMS 

In spectroscopy, it is essential to know which frequencies are absorbed and 

which are not. This requires that the radiation source covers a broad 

spectral range and the individual frequencies of the radiation are 

analyzed. 

In the conventional dispersive-type spectrometer, a grating or a prism is 

used to disperse light into individual frequencies, and a slit placed in 

front of the detector to determine which frequency to reach the detector. 

However the FTIR spectrometer operates on a different principle called 

Fourier transform. The mathematical expression of Fourier transform can be 

expressed as 
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And the reverse Fourier transform is 
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where ω is angular frequency and x is the optical path difference in our 

case. F(ω) is the spectrum and f(x) is called the interferogram. 

It is clear that if the interferogram f(x), is determined experimentally, 

the spectrum F(ω) can be obtained by using Fourier transform. The 

relationship between the interferogram and the spectrum will be explained 

more fully in the latter sections. Section 3 explains how to measure the 

interferogram using Michelson interferometer. 

 

3.  THE MICHELSON INTERFEROMETER 

The basic Michelson Interferometer consists of (see Fig. 1): 

• a broad-band light source which emits light covering the mid-IR range, 

• a beamsplitter made of KBr or CsI, 

• Two front surface coated mirrors – one moving and one fixed, and 

• a detector. 

 

 
 

 Fig.1  Schematic diagram of a Michelson Interferometer. 
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The working principle of Michelson Interferometer 

1) Light from the light source is directed to the beamsplitter. Half of 

the light is reflected and half is transmitted. 

2) The reflected light goes to the fixed mirror where it is reflected back 

to the beamsplitter. The transmitted light is sent to the moving mirror 

and is also reflected back towards the mirror. 

3) At the beamsplitter, each of the two beams (from the fixed and moving 

mirrors) are split into two: one goes back to the source (and “lost” 

since it does not reach the detector) and the other goes towards the 

detector. Hence the detector sees two beams: one from the moving mirror 

and the other from the fixed mirror. 

4) The two beams reaching the detector come from the same source and have 

an optical path difference determined by the positions of the two 

mirrors, i.e. they have a fixed phase difference. Therefore the two 

beams interfere. 

5) The two beams may be made to interfere constructively or destructively 

for a particular frequency by positioning the moving mirror. If the 

moving mirror is scanned over a range (corresponding to x in 

Section 2), a sinusoidal signal will be detected for that frequency 

(see Fig. 2), with its maximum corresponding to constructive 

interference and the minimum corresponding to destructive interference. 

This sinusoidal signal is called interferogram – detector signal 

(intensity) against optical path difference. 

6) Assume a light source which emits only two frequencies, each frequency 

will produce its own sinusoidal interferogram. Both interferograms will 

have maximum at optical path difference δ equals to zero (corresponding 

to the point that the two mirrors are equidistance from the 

beamsplitter). But the other maxima will not coincide, since their 

positions are determined by the equation 

   in2x2 λ=∆=δ     ,   2,1i λλ=λ  

where ∆x is the difference in the distances between the beamsplitter and 

the two mirrors. 
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7) Because the source emits a range of frequencies, the detector output is 

the sum of all the interferograms. The resulting inteferogram will have 

a maximum at ∆x = 0 (centreburst) and tails off rapidly away from the 

centreburst. 

 

 

       spectrum                      detector signal 

                     
 

Fig.2 Relationship between spectrum and interferogram (detector 
signal). The axis for the detector signal is the optical path 
difference (see text). 

 
 

 

4.  GENERATING THE SPECTRUM 

• As has been explained earlier, interferogram is determined 

experimentally in FTIR spectroscopy, and the corresponding spectrum – 

frequency against intensity plot, is computed using Fourier  transform. 

This transformation is carried out automatically and the spectrum is 

displayed. You may not realize this mathematical transformation taking 

place. 
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• The detector sees all the frequencies simultaneously, whereas in a 

dispersive spectrometer, only one frequency can reach the detector at 

one time. 

• FTIR spectrometer is inherently a single beam instrument. It is 

imperative to record a relevant background spectrum for each sample 

examined. 

• Background spectrum:  The empty beam background (no sample in the light 

path) is recorded first. This spectrum shows the instrument energy 

profile, which is affected by the characteristics of the source, the 

beamsplitter, the absorption by the air (mainly due to CO2 and water 

vapour) in the beam path, and the sensitivity of the detector at 

different wavelengths. 

• Sample spectrum:  The sample is placed in the combined beam (just 

before the detector in Fig. 1). The sample spectrum is the ratio of the 

spectrum containing sample against that of the background. 

• In recording the background spectrum, the light path should be made as 

close to that of the sample spectrum as possible. For example, in 

transmission experiment, the background may be recorded with nothing in 

the light path whereas it should be recorded with KBr powder in the 

DRIFT experiment. 
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EXPERIMENT 1     TRANSMISSION SPECTRUM OF POLYSTYRENE 

INTRODUCTION 

This experiment is designed for the students to be familiar with the basic 

theoretical principle and the operation of the FTIR spectrometer. 

Transmission is the most widely used and most fundamental mode of 

operation. It is also the easiest to understand and to perform. 

When a monochromatic EM wave of intensity I0 passes through a specimen, 

absorption (and reflection) occurs and the intensity transmitted can be 

expressed according to the following relationship 

     deoII α= −  

where d is the thickness of the specimen and α is called the absorption 

coefficient. In the IR spectral region α is a strong function of the 

frequency of the incident light. 

The quantity t = I/I0 is called the transmittance and αd is proportional to 

a quantity called absorbance (= αd/ln 10). Transmittance and absorbance are 
the two parameters used most often in spectroscopy. 

 

EXPERIMENT 

Collect the background spectrum 

1) Start the FTIR-8400S software by clicking the IRsolution icon on the 

desktop. 

2) Click Measure tab. 

3) Pull down the measurement menu and select Initialize. 

4) Wait a few seconds for the lamp and mirror green indicators to appear 

on the Status Monitor Window on the right. 

5) Set the following scan parameters on the Scan Parameters Window on the 

bottom right: 

i) Measurement mode: % Transmittance 

ii) Apodization     : Happ-Genzel 

iii) Number of scans : 20 

iv) Resolution      : 4 
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6) Enter an appropriate spectrum name in the comment box. 

7) Click BKG to start scanning the background. 

8) The background spectrum (energy spectrum) collected includes 

contributions from the light source, beamsplitter, air (carbon dioxide 

and water vapour) and window absorption. 

9) Pull down the File menu and select Print to obtain a hardcopy of the 

spectrum. 

 

Collect the polystyrene spectrum 

1) Mount the polystyrene sample onto the sample holder. 

2) Click Measure tab. 

3) Enter an appropriate spectrum name in the comment box. 

4) Click Sample tab to start the scan. 

5) When scanning is completed, perform the following steps for peak 

detection and labelling: 

a. Click Calculate tab on the right window 
b. Enter suitable values for Noise, Threshold and Min Area 
c. Click Calc button followed by OK button to display the results 
d. To increase or decrease detected peaks, repeat steps b and c 

6) Print the spectrum. 

7) Repeat the scan for polystyrene using the following measurement modes: 

a. Absorbance 
b. Interferogram 
c. Power  

Note:  

Noise  
 

Enter the noise level (0 to 1). Values larger than this level 
are identified as peaks. 

Threshold 
 

Peaks with larger absorbance than [Threshold: 0 to 5] are 
detected when the spectrum is in absorbance mode. Peaks with 
smaller transmittance than [Threshold: 0 to 100] are detected 
when the spectrum is in transmittance mode. 

Min Area 
 

Enter the minimum area. The values larger than this area are 
identified as peaks. 
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DISCUSSION 

1) Discuss the background energy spectrum, e.g. identify the sharp bands 

and discuss the contributions to the overall profile. 

2) From the power spectrum of polystyrene, perform a ratio against the 

background spectrum. Refer to appendix A for operating details. 

3) Make general comments about the interferogram and power spectrum of 

polystyrene. 

 

EXPERIMENT 2     ATTENUATED TOTAL REFLECTION (ATR) 

INTRODUCTION 

Under certain conditions, infrared radiation passing through a prism made 

of a high refractive index infrared transmitting material (ATR crystal) 

will be totally reflected. When total internal reflection occurs, there 

exists an evanescent wave extends beyond the surface of the crystal. Hence 

when a sample is brought in contact with the totally reflecting surface of 

the ATR crystal, the evanescent wave will interact with sample. It will be 

attenuated in spectral regions where the sample absorbs energy and hence a 

spectrum can be obtained. The IR light undergoes several reflections inside 

the crystal to increase the interaction with the sample (see the wall 

display for an illustration). 

ATR produces a very short pathlength of the IR light in the sample. This 

makes this technique ideal for highly absorbing materials such as aqueous 

solutions, rubber and polymers. 

The depth of penetration into a sample is given by the equation: 
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where λ   = wavelength (in air) 

 np  = refractive index of prism 

 ns  = refractive index of sample 

 nsp = ns/np 

 θ   = angle of incidence 
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At 45 degrees with KRS-5 crystal this translates into a depth of 

penetration of 0.1 – 0.2 of wavelength (a few micrometer). Simply stated, 

dp is smallest for materials of high refractive index and for high 

incidence angles. This dependence of band intensities is more prominent in 

thick samples as complete penetration occurs in thin samples. 

 

EXPERIMENT   -  LIQUID ATR 

1) Place the ATR accessory into the sample compartment of the 

spectrometer.  

2) Collect a background spectrum through the empty ATR accessory. 

3) Remove the trough from the assembly. Fill it with acetone and replace 

it back into the assembly. 

4) Collect an absorbance spectrum of the acetone. 

5) Make a solution of ~50% acetone and ~50% distilled water and collect a 

spectrum of this mixture. 

6) Also collect an absorbance spectrum of distilled water. 

7) Perform spectral subtraction, using an appropriate factor, between the 

acetone/distilled water mixture and distilled water, to obtain the 

spectrum of acetone. 

 

DISCUSSION 

1) Explain how the spectrum subtraction is performed. 

2) Does the difference spectrum look similar to the pure acetone? Why or 

why not? 

 

 

Revised Oct 2008 
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Appendix A 
 
[Manipulation 2]-[Dataset] 

 

Performs addition, subtraction, multiplication, and division between spectra.  
Calculations are performed between a source spectrum and a reference spectrum multiplied 
by a factor. The factor value can be increased or decreased while observing the resulting 
spectrum. You can select a spectrum in the tree view after specifying either Source or 
Reference.  

Spectral Subtraction 

The subtraction of a spectrum from another spectrum is known as a "Spectral Subtraction".  
Normally, spectral subtraction is used to subtract the spectrum of a known component from a 
spectrum with mixed components, and allow for calculation of the spectrum of the other 
component. For example, when spectrum S(B) of known component B is subtracted from 
spectrum S(A+B), which contains components A and B, spectrum S(A) of component A can 
be obtained by calculation. This is called the subtracted spectrum method.  
Practically, the reference spectrum must be multiplied by an appropriate factor, taking into 
account the concentration ratio of the known component of the source spectrum and reference 
spectrum before obtaining the subtracted spectrum. The concentration ratio can be calculated 
by comparing the absorbance of the absorption peak that is only seen in the known 
component in one spectrum with that in the other spectrum. 
For the above example, spectrum S(A) can be obtained by multiplying spectrum S(B) by the 
factor that may cancel out the absorbance of the peak particular to component B and then 
subtracting the multiplied spectrum S(B) from spectrum S(A+B). 

  
Relation between IRsolution manipulation function and the Lambert-Beer's Law  

• The photometry mode for manipulations on the spectrum is basically absorbance. 
Because concentration is related with absorbance described as the Lambert-Beer's 
Law. Perform manipulations for the transmittance spectrum after the absorbance 
conversion is automatically performed. For the parameter, enter the value based on 
the converted absorbance spectrum. Care must be taken for the data processing on the 
transmittance spectrum.  

• Put a check mark on the [Disable Lambert Beer] on the [Environment]-[Manipulation 
Preferences]  to manipulate transmittance spectra in the transmittance mode. This 
check mark is removed after manipulation every time. When you repeat manipulation, 
please put the check mark every time.  
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Parameters 
 
Arithmetic 
 
You can select the calculation type from the following options.  
 
Add 2 Datasets Result = Source + Reference x Factor 
Subtract 2 Datasets Result = Source - Reference x Factor 
Multiply 2 Datasets Result = Source * Reference x Factor 
Divide 2 Datasets Result = Source / (Reference x Factor) 
 
Factor 
 
Value You can specify the constant to be used for the mathematical operations. To enter the constant, 

type with the keyboard or drag the scroll bar. (0< factor <1) 
 
  
Scrolling 
 
Scroll Bar You can change the value by the scroll bar. The Value increases or decreases with "Factor" 

intervals by clicking the small points on either end of the scroll bar. The values are also 
drastically changed by sliding the slider. 

Factor You can set the scroll increment when the small points on either end of the scroll bar is 
clicked. 

 
  
Switch S/R 
 
Spectrum is loaded as reference or source spectrum according to the setting. 
 
Source Loads the source spectrum.  
Reference Loads the reference spectrum.  
 
  
 
AutoCalc 
 
When check mark is on the [AutoCalc] section, the software automatically determines the 
factor with which the intensity at the wavenumber position corresponds to the clicked 
position becomes "0" (or "1" when multiplication or division has been selected) in the 
resulting spectrum, and then starts the specified calculation with clicking the <Clac> button. 
When you click the [>>] button, a vertical cursor appears in the source spectrum area. And 
then you can adjust the factor after removing the check mark. 
 
  
Buttons 
 
Calc Executes the calculation and displays the result. 
OK Confirms the calculation result and displays the resulting spectrum in the [View] tab. 
Clear Cancels the calculation and displays the unaltered spectrum in the [View] tab. 
Help Displays the help window. 
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 Operation 

1. Activate the spectrum tab to be manipulated in the View tab.  

2. The active spectrum will be indicated in bold on its spectrum tab. 

3. Select the Dataset command from the Manipulation 2 pull down menu.  

4. Click the Source radio button and select a source spectrum in the tree view window 

on the left, if necessary.  

5. Click the Reference radio button and select a reference spectrum in the tree view 

window to overlay both spectra.  

6. Select the Arithmetic option.  

7. Adjust the factor in "Value" and click the Calc button. Continue the adjustment until 

an appropriate result is obtained.  

8. Click the OK button to confirm the result and display the resulting spectrum.  

 
Note 
 
After you have selected [Divide 2 Dataset], if you select a reference spectrum that contains a 
wavenumber whose intensity will be "0" as a result of the calculation, an error message is 
displayed, and the calculation is aborted. The same error occurs when you enter "0" as a 
factor.  
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